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1 The DVR Interface for Rapid EyeTM
1.1 Preface
This manual describes the how to register, configure and operate the GCS RapidEye DVR Viewer in
the System Galaxy software (SG). Installation of the DVR hardware/cameras is covered in the
Honeywell-RapidEye Product Manuals.

A note about NOTES:
Original instructions include general notes.
General Notes are are disignated with the word “NOTE”, “IMPORTANT” or “WARNING”.
Original Instructions and General Notes always apply unless superseded by a versioned note.
Versioned notes are vital details that support ongoing changes to sofware functionality. They
apply to the specified version (or higher) unless superseded by a later versioned note.
•

“NOTE” = always read and apply as appropriate.

•

“IMPORTANT” or “WARNING” = always read and apply as appropriate.

•

“SG-6.5 NOTE” = always read and apply to SG6.5 (or later/higher) as appropriate.

• “SG-7 NOTE” = read only if you are using SG-7 (or higher) - apply as appropriate.

1.2 Introduction to SG’s DVR Software Interface
The following sections provide an overview of key details regarding the DVR Interface in SG.
The GCS DVR Interface for RapidEye was first implemented in System Galaxy 6.4 software.
The Galaxy Control System (GCS) RapidEye DVR Interface streamlines the Surveillance and Access
Control systems by allowing time-synchronized, “on-demand” video viewing from within the System Galaxy
software. The user can select and view video from a distinct alarm or event message on monitoring screens
and reports, as well as by individual device icons (i.e. door, reader, input) based on the setup of features.
The Rapid Eye DVR provides ‘continuous recording’ and sends video frames to GCS RapidEye DVR
Viewer when requested from System Galaxy software.
SG 6.5 NOTE: Automatic Live Video on SG-Alarm Event: a “camera linked” reader or input that is
configured to trigger an SG Alarm Event (ack) can cause the DVR Viewer can automatically pop open and
play live feed when the input is in the ‘armed alarm’ condition. (Alarm Options programming including
alarm priorities apply).
SG 7 NOTE (or higher): Blocking the GCS DVR VIEWER on a per workstation basis and blocking the
Viewer on Alarms is done via software options. See Section 4.1 for details.

SG 7 NOTE: DVR Support Enabled must be “ON” in Client Gateway (see Section 2.4.2)
IMPORTANT! It is recommended to complete the installation and setup of the RapidEye
Surveillance System before configuring System Galaxy for the DVR Support/Interface. See the
Honeywell Installation and Product documentation for installation and setup of the RapidEye Video
equipment.

4

Software Interface Manual  GCS

RapidEye DVR

1.3 Overview of GCS DVR Interface
The GCS RapidEye DVR Interface is an integrated part of System Galaxy v6.04 or higher.
The main function of the DVR Interface is to provide the ability to link cameras (surveillance areas) with System
Galaxy devices (i.e. doors/readers/inputs) and to allow automated and on-demand playback of live or recorded
video feed. The playback of video is displayed by the GCS DVR Viewer.
The GCS DVR Viewer opens when an operator selects a ‘view video’ option within System Galaxy. The GCS
DVR Viewer can automatically open and play live video when an armed alarm is triggered. Video playback will
be based on configuration and alarm priority. The ‘View Video’ options are available throughout System Galaxy
Short Menus after proper registration and configuration is completed.
Chapter 1: Introduction, Overview, System Requirements, System Diagram, High-level Features
Chapter 2: Setting up dependant options in Rapid Eye software and configuring System Galaxy
Chapter 3: Operating GCS RapidEye DVR Interface
Chapter 4: Getting ‘On Demand’ video feeds by devices or messages/events
NOTE: The operation of the GCS RapidEye DVR Interface and Viewer is dependant on (a) the setup of certain
parameters in the Rapid EyeTM Multi-Media System/client software, and (b) the setup and configuration of
System Galaxy software. This information is included in the setup instructions in Chapter 2.

1.3.1 About Honeywell’s Rapid EyeTM Technology
This part of the manual covers noteworthy key points about the Rapid Eye technology. The Rapid Eye TM
DVR Unit and Software is not a product of Galaxy Control Systems. Contact the manufacturer for more information
about their products.
 Installation of DVR (and surveillance system) is independent of System Galaxy, as
illustrated in the Interface Diagram (See Fig1). However, System Galaxy is dependant on
certain features being configured appropriately in order to support the DVR Interface. See later
sections of this manual.

 The Rapid EyeTM Multi-Media DVR unit utilizes typical LAN/WAN connection.
Note: The SG-Loop Communication PC (LCS) interfaces with the DVR using the specified TCP/IP
parameters of the DVR unit. The IP Connection Settings in System Galaxy’s DVR Programming
screen must match the parameters of the DVR Unit. See later sections of this manual.

 The Rapid EyeTM DVR supports multiple camera connections per DVR Unit.
System Galaxy inputs/doors (reader ports) can be “associated” with cameras, thus allowing the ability
to monitor areas where readers or sensors are placed. See section on setting up System Galaxy.
NOTE: Rapid Eye technology does not allow System Galaxy to control camera positions or trigger video
recording.

 The Rapid Eye DVR requires common master source for clock synchronization.
The DVR time and System Galaxy time must be in synch to a common clock in order to allow accurate
video storage/retrieval for alarms and events. The DVR can be synched to the Galaxy LCS (depending
upon operating system) or other master clock source. See the Section 2 for details on setting up for
Time Synchronization.
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1.3.2 System Diagram of GCS DVR Interface
The diagram below shows a Galaxy Access Control System with TCP/IP connection to a RapidEye Video System.
Notice that there is not a direct connection between System Galaxy hardware and video surveillance hardware (i.e.
DVR, cameras). Cameras are physically connected to the DVR on the “video surveillance side”. GCS DVR
Interface uses a Network (TCP/IP) Connection to view a camera’s video once the camera is “associated” with a
System Galaxy door or input.
Figure 1: System Diagram - GCS Access Control & Surveillance Interface

Rapid Eye Admin1 & View2, 3
software must be installed at
every PC/Workstation that
requires viewing capability.

NTP Master Clock Source4

Internal Network Server or SG-LCS5
External Network Server (USNO)

Footnotes:

1 – Rapid Eye Admin software: surveillance “site” must use the same IP Address as the Rapid Eye DVR
2 – Rapid Eye View software: surveillance “site” must be in “live” status to view video feeds.
3 – Rapid Eye View and System Galaxy: time synchronization must be configured to a “3rd Clock Source” such as an
internal Network Server or and external Internet Time Server; ex. US Naval Observatory (USNO).
4 – Master Clock Source: The DVR and System Galaxy must be synched to the same clock source.
5 – Time Synch to Galaxy LCS: DVR can be synched to the Loop Communication Server (LCS) if the operating system
supports a Time Service (Windows 2000, XP or higher).

SG 7 NOTE: DVR Support Enabled must be “ON” in Client Gateway (see Section 2.4.2)
.
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1.3.3 System Requirements
The following list constitutes minimum requirements for interfacing with Rapid Eye.
SG 7 TERM: the “SG Server” (in SG 7.x) is the interchangeable term for “LCS” (in SG 6.x).

9 The Loop Communication Server (LCS) must be running System Galaxy v6.04 or higher.
9 The Loop Communication Server (LCS) must have LAN/WAN connectivity in order to interface with

the Rapid Eye TM DVR.
Note: The connection type between SG and the DVR is independent of the connection type between SG
and the SG Hardware.
The connection type (i.e. LAN, RS232, etc.) between SG Software and System Galaxy Controllers
may vary depending on which version of System Galaxy software is being used, but has no
bearing on connection type with the DVR. The controller panels and their peripheral devices
(readers, inputs, etc.) do not connect directly to the DVR Unit or its cameras.
9 Rapid Eye Multi-Media Client software must be installed on the Loop Communication Server (LCS) and any
WorkStation that requires video viewing capability (Refer to manufacturer’s instructions for correct
installation). Rapid Eye requirements and documentation are produced and administered by
Honeywell/Ademco.
Note: User will be alerted during RapidEye Software installation for required components not
found on PC. Rapid Eye installation cannot complete until these are met. Contact
Honeywell/Ademco for assistance. The following are some of the requirements commonly
encountered.
!

The PC(s) must have a compatible version of MDAC installed (per Rapid Eye requirements)

!

The must have a compatible version of Acrobat Reader (per Rapid Eye requirements)

9 The System Galaxy software must have the GCS_RapidEye.exe DVR Interface registered.
SG 7 Note: Installer will need to use the DVR Support option to register RapidEye in SG 7. The prior
versions of SG used a brand-specific checkbox for Rapid Eye. This older option will be visible but
grayed out in SG 7 and registration will use the ‘DVR Support’ checkbox.
9 System Galaxy must have the Rapid Eye Login parameters that allow for retrieval of live and recorded video
(search and view).
9 There should be a common master clock source for both System Galaxy and the Rapid Eye DVR unit. It
appears that RapidEye supports time synchronization at the software application level on the DVR. Time
synchronization can also be managed at the operating system level as an optional solution.
NOTE: At the time of this manual’s creation, System Galaxy v6.4 is compatible with the SDK for RapidEye DVR.
NOTE: To support changes in System Galaxy software this manual is amended with versioned tech notes.
Versioned tech notes may supersede the original or prior functionality. See Section 1.2 for a description
and example of versioned tech notes.

SG 7 NOTE: DVR Support Enabled must be “ON” in Client Gateway (see Section 2.4.2)
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2 PC & WorkStation Setup for Rapid EyeTM
This Chapter describes how to register and configure System Galaxy to interface with the DVR, how to
configure the devices and how to validate the camera/device connections.
IMPORTANT! It is recommended to complete the installation and setup of the RapidEye System
before configuring System Galaxy for the DVR Support/Interface.

2.1 Task List: CONFIGURATION PROCEDURES
The Task List below outlines the steps to registering, programming and validating the configuration.

Table 2: Check List for System Galaxy with Rapid Eye
Installation Steps
Part 1. Get DVR network connection parameters.
Part 2. Rapid Eye Multi-Media Client Software ‘Admin & View’:
This part covers only the requirements that need to be setup in the
Rapid Eye Client software for GCS DVR Interface to function. Refer
to Manufacturer’s documentation for anything outside the scope of
this manual.
Part 3. Registering Rapid Eye DVR Interface in System Galaxy.

Original References
See Section 2.2 of this manual and the
Manufacturer’s Info. or site IT/Network
Technician.
See Manufacturer’s Info. in addition to
Section 2.3 this manual.

Section 2.4 for registration and

Part 3b SG7.x (or higher) must enable (check) DVR Support
option in Client Gateway Service – Options tab

SG Software Guide, Steps 1 thru 17 for
Main Setup and Installation Information
as appropriate and include steps from.

Part 4. Adding a DVR Site Definition

Section 2.5 of this manual
Section 2.6 of this manual

Part 5. Associating cameras with Readers/Inputs
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2.2 (Part 1) DVR Network Connection Parameters
Obtain the network IP Address from the DVR Unit. The DVR’s IP address will be used in setting up the Rapid Eye
Admin software. System Galaxy must use the same parameters as the DVR in order to interface with the
surveillance equipment.
To find the DVR IP Address, open the DVR’s software application. This is the software that resides on the DVR
Unit itself and may require a password.


Contact the DVR Site Administrator or IT professional for assistance with passwords as needed
since passwords are unique/site specific.

Once the DVR application is open, navigate to the ‘Setup Menu’ tab and select the ‘System’ tab to view the
network connection information. The IP Address displayed in this screen must be used to Setup the System Galaxy
Interface.

2.3 (Part 2) Installing Rapid EyeTM Admin & View
This section includes guidelines for only those parameters that are important for System Galaxy Interface and only
focuses on the points that the DVR Interface is dependant upon.
Rapid Eye Admin & View software should be installed on the Galaxy Loop Communication PC (LCS) and every
WorkStation that requires access to video feeds. Both the ‘Admin’ and ‘View’ software components must be
installed.
The Admin & View Installation/Setup Procedure (Table 3) is broken into the following three sections:


Installing the Rapid Eye client software: Admin and View components.



Setting up Admin software: Configuring the “Site” IP Address with the DVR IP Address



Setting up View software: Connecting to the DVR, checking for video, naming cameras, time
synchronization.

Table 3: Rapid Eye Admin and View Installation and Setup Procedure
Installing Rapid Eye Multi-Media Admin & View at the WorkStation :
STEP
1

2

3

ACTION
Installing Rapid Eye Admin & View:
Place the Rapid Eye Multi-Media CD in computer CD-drive and
allow the drive to spin-up and automatically display the explorer.
HINT: If the CD-drive does not spin-up, user can navigate to the
CD-drive via the Windows’ File Explorer utility.
(Right-click the Window’s [Start] button and chose ‘Explorer’
from the short menu.)
9 Double-click the “Setup” file (Setup.exe) to initiate the
software installation.

9 Select the [Admin and View] option button.
Note that both the Admin and View components must be installed.

9

RESULT
Windows’ File Explorer screen opens an
the Rapid Eye CD contents display.

The Rapid Eye splash screen
displays followed by the Installation
dialog displays with selectable option
buttons.
The component installation will run.
Admin and Viewer will be placed in
the Programs folder and shortcuts will
be placed on the PC’s desktop.
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Once the Rapid Eye client software has been installed on the
System Galaxy PC, the user will need to follow manufactures
instructions for setting up the Admin and View components.

See Manufacturer’s documents for the
proper setup.

Setting up Rapid Eye Multi-Media Admin: (where the surveillance ‘Sites’ are created)
STEP
5

ACTION
Start up/open the Rapid Eye Multi-Media Admin:
Double-click the ‘Rapid Eye Admin icon’ on the PC desktop or
navigate to Windows’ Start>Programs Menu>Rapid Eye Admin.
Note: When starting Rapid Eye Admin, supply necessary login, and
password.

RESULT
See Section 2.2 Part 1 of this
document.
Admin Login screen displays
followed by the Admin Site screen
when a valid password is
supplied.

6

Opening the appropriate DVR Site Name: perform either a or b fro
this step as appropriate
a) The Update Site screen
a) If the DVR Site Name already exists: Select/highlight the
opens.
desired site name from the Sites list box and double-click the
OR item to open the Update Site screen.
b) If no ‘DVR Site Name’ has been added yet: click the Add Sit
b) The Add Site screen opens
option in the Actions menu. Refer to proper manufacturers
allowing user to add the new
instructions on setting up the DVR Site
site name.

7

Setting up the DVR Site Connections:
a) If the Update Site screen was chosen, select/highlight the line
item in the Connections list box and double-click to open the
Connections window.
b) If the Add Site screen was chosen, then follow the necessary
steps to provide the site name and add connections.
Enter the IP Address of the DVR unit.

The Connections window opens
displaying the site name and its
[IP Address] field.

The IP Address value must match
the IP Address of the DVR unit.

Setting up Rapid Eye Multi-Media Viewer: (where surveillance ‘sites’ are setup and operated)
STEP
8

ACTION
Start up/open the Rapid Eye Multi-Media Viewer:
Double-click the ‘Rapid Eye View icon’ on the PC desktop or navigate
to the Windows’ Start>Programs Menu>Rapid Eye View.
Note: When starting Rapid Eye Viewer, supply necessary login and
password.
The Rapid Eye ‘View Window’ has 3 parts:
1) The Menu and Tool Bars (top)
2) The Action tabs (left pane) which include a Sites tab with an
object tree of the available Site names. The tree shows a
plus (or minus) symbol beside the site name to indicate that
the Site name object can be expanded
3) The Session pane (right) which displays content based on
user selections from the Menu, Tool buttons or Action tabs
(i.e. Maintenance and video screens appear here).

10

RESULT
Viewer Login screen displays
followed by the View Sites screen
when a valid password is
supplied.
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10

11

Checking for video ‘live feed’ viewing:
1) Double-click the ‘site name’ in the object tree to open a
list of available cameras (dialog pop-up) in the Session
pane (right pane). The connection should occur
automatically.
2) Select desired camera(s) from this list to allow live feeds
to display in the Session pane.
NOTE: Click the (+) beside the site name in the Action pane to
expanding will display the connection status which should be
showing “connected”, “Live” and the amount of time elapsed.

RapidEye DVR

1) The ‘Select stream for live
from sitename’ dialog displays
with a list of available
cameras.
2) Live feed screen displays for
the selected cameras.

HINT: To get a different camera you may need to disconnect and
reconnect from the Site tree in the left pane and select desired
camera(s).
Naming Cameras: can be done in the Maintain screen.
1) The Maintenance screen
1) Select Actions>Maintain... from the Menu Bar, (or click the
opens in the Session pane.
[Maintain] button on the tool bar). Select the Video tab.
The Video tab displays
showing a list of cameras on
2) Click the desired camera twice (slowly) in the list to
the left corner of the
select/highlight the camera name and edit the camera name as
Maintenance screen.
needed.
NOTE: if a camera name is changed/edited here while System
2) The camera name is changed
Galaxy is running, simply update the GCS-DVR Viewer’s camera list
as edited.
by restarting the GCS-DVR Viewer. (See Section 3.1.1 for notes on
Auto-Run mode and Restarting GCS-DVR Viewer).
Synchronizing the time to a common clock source: This is
mandatory in order to “associate” a System Galaxy alarm/event
with a relevant video feed (live or historical).
1) Select Actions>Maintain... from the Menu Bar, and Select
the Time tab.
2) Select the ‘Automatic’ option and supply the correct
SNTP Server Address for the desired server running a Time
Service. This can be the LCS if the LCS has a time service
available or a 3rd server – See below.
Choosing a common Master Clock Source:
a) If System Galaxy LCS-PC has a Time Service (Windows
2000, XP or higher), then the surveillance site can be
synched to this service on the SG-LCS.
b) If the System Galaxy LCS does not have a Time service
available (i.e. NT), then both the surveillance site time and
System Galaxy loop time must synch to a common master
clock. In this case two options are possible.
¾ Use the address of an internal Network Server that has a
Time Service available.
~ OR ~
¾ Use the address of an external Network Server that has a
Time Service available (i.e. World Wide Web). The US Naval
Observatory is an example of the type of time server the
customer may choose.
IMPORTANT: if a common clock is not chosen then video
feeds cannot be matched to alarm/events in System Galaxy.
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The Time tab displays with
settings user chooses.
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2.4 (Part 3) Registering DVR Support in System Galaxy
Use this Manual to assist with registration, setup and operation the GCS DVR Interface. Refer back
to main SG-Software Guide for the normal installation/upgrade instructions.

! New Installation will always require registration of SG System. Refer to SG-Software Guide.
! Adding RapidEye to an existing system does require registration. See below.

2.4.1 Registering the RapidEye DVR:
The Rapid Eye DVR must be registered in the SG Product Registration Screen using the following steps.
1) Open SG Product Registration screen - from menu options Configure>Options>Registration>System
2) Check the appropriate DVR checkbox:
; SG 6.4 & 6.5 NOTE: Use the ‘Rapid Eye DVR’ checkbox as shown in figure 2a
; SG 7 NOTE: Use the ‘DVR Support’ checkbox as shown in figure 2b. User will be able to see the
older ‘Rapid Eye’ option grayed out, but will use the new DVR Support option to register.
3) Click [Apply] button
4) Click [OK] button
5) Restart System Galaxy software application after registration is complete: this allows the DVR Interface to
startup. The GCS DVR Viewer will run minimized when initially started.
Figure 2a: Product Registration Screen – RapidEye DVR in SG 6.4 or 6.5

SG 6.x the Rapid Eye DVR checkbox must be checked.

Figure 2b: Product Registration Screen –DVR Support in SG 7
SG 7 the Rapid Eye DVR checkbox must be checked.

The old Rapid Eye DVR checkbox will be grayed out and show the prior
configuration as follows:
; CHECKED if site had RapidEye under prior SG 6.x installation
; UNCHECKED if site did not have prior DVR or site is a new
installation.
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Set DVR Support in Client Gateway Service (SG-7 or higher)

If the System Galaxy version is SG7.x or higher, the DVR Support Enabled option must be checked in the
GCS Client Gateway Service using the following steps:
1) Open the GCS Client Gateway Service window - from the desktop System Tray (right side of the
taskbar). To do this the, user must double click the on the Client Gateway ICON.
2) Open the Option Settings tab - from Gateway’s Service window’s menu. To do this, the user must
select Setup > Configure...; then select the Option Settings tab.
; Check the “DVR Support Enabled” check-box
; Click [Apply] button
; Click [OK] button
3) Close the .GCS Client Gateway Service window – by clicking the [X] button on the top of the
window.
4) Click the [Hide GUI and Keep Service Running] button to return the service to the task tray.

IMPORTANT: If the Gateway Service is inadvertently stopped, then the service must be
restarted to restore Event Monitoring to the System Galaxy program (i.e. all workstations
will temporarily stop receiving events for the loops until Client Gateway service is running.
Loops and panels continue to operate offline in a fully functional mode. Event Buffers are retransmitted to
the database if the panels were off-line from the database once the GCS Communication Service and GCS
DBWriter Service are restored. IF only the Client Gateway offline, then the real-time events that occurred
are available in the database (i.e via Activity History Reports) .
1) To restart the Client Gateway Service, user must open the Services Manager window by one of the
following paths:
 Right-click the My Computer ICON on the desktop and pick Manage from the short menu. Then
navigate to and select the “Services” ICON on the object tree.
 OR- - Click the Windows [Start] button and select Settings > Control Panel. Double-click on
Administrative Tools. Double-click on Services to open the list of services.
2) Scroll down to the “GCSClientGWservice” in the list of Services. Right-click the
“GCSClientGWservice” name and choose Start from the short menu
NOTE: Services are explained in detail in the Main SG-7 Software Manual (first or second editions)
SG 7-2 NOTE: SG-7.2 or higher may come with the SG Services Manager. Starting/restarting
services can be handled via this utility if it is running. (The SG Services Manager is described in the
main Software Manual for SG-7 Second Edition)
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2.5 (Part 4) Adding a DVR and Cameras
2.5.1 Adding a DVR
SG 6.X NOTE: DVR programming is found in the Rapid Eye tab in the WorkStation Options screen:
SG 7 NOTE: DVR programming is found in the DVR screen under the main System Galaxy Menu Bar by selecting
‘Configure/Hardware/DVRs’.
1) Click [Add] button and enter the DVR Name: this Name must match the ‘Site Name’ used in the ‘Rapid
Eye Admin’ client software. Reference Section 2.3, Table 3 steps 5-7.
2) The ID Number is automatically assigned by System Galaxy
3) SG 7 NOTE: Choose the “Rapid Eye” from the [DVR Type] as shown in figure 3b.
4) SG 7 NOTE: Enter the IP address of the DVR Server Unit. (port # not required, leave empty)
5) Enter User Name and Password: which must match the settings used in the ‘Rapid Eye Admin’ client
software. Reference Section 2.3, Table 3 steps 5-7.
6) Restart System Galaxy software. Once SG is restarted, the new DVR will display in the DVR drop list.
Multiple DVR’s can be added in this screen.
Figure 3a: Workstation Options / RapidEye DVR Settings for SG 6.x

DVR Selection drop list is populated
with new DVR name after changes
are applied.

DVR Name must match the Site Name from the
Rapid Eye Admin Update Site screen. This name
will appear on the GCS DVR Viewer title.
DVR Security Settings must match the Log On and
Password from the Rapid Eye Admin Log On screen.
Figure 3b: Workstation Options / RapidEye DVR Settings for SG 7.x

SG 7 NOTE: in addition to the settings shown in
figure 3a (above), the SG 7 user will also need to
select the DVR Type and enter the IP Address for
the DVR Unit. Port # is not used with RapidEye.
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2.5.2 Adding Cameras
SG 6.X NOTE: Camera programming done in the RapidEye Client software. See Table 3: Step 10 in Section 2.3.
SG 7 NOTE: Camera programming is done in the DVR Cameras screen under the main System Galaxy Menu Bar
by selecting ‘Configure/Hardware/DVR Cameras’.
In SG 7, 16 Camera names are automatically populated when a DVR is added. The camera names can be
changed to more logical names (i.e. Lobby, Exit Door). Note that unused cameras will show up in all camera lists,
however unused camera names can be deleted and added back later if desired.

Camera Names have been renamed in this example
and extra/unused camera names have been removed.
Camera names can be re-added as desired.
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2.6 (Part 5) Associating Readers & Inputs with Cameras
A new Rapid Eye tab has been added to both the Doors screen and Inputs screen. These instructions apply to
Elevator doors as well as standard doors.
NOTE: The ‘RapidEye DVR Settings’ tab is also available in the Elevator properties screen In the case of a true
Elevator device, the red door icon will be displayed in the hardware tree.

2.6.1 To “associate” a Camera with a Door/Reader device:
1) Open the Door Properties screen (from the Menu Bar, select Configure>Hardware>Door/Reader)
¾ TIP ~ Open Door Properties screen from short-menu by right-clicking the desired door/reader icon in
the Hardware Tree, then selecting the ‘Properties’ option as illustrated. Loop, Controller and Reader
Name fields should auto-fill to desired values when screen opens.
2) Choose the desired Loop, Control Unit and Reader Name from drop lists as necessary
3) Select the ‘RapidEye DVR Settings’ tab and click [Edit] button (fields become enabled).
4) Pick the desired DVR and Camera from the drop lists.
5) (optional) Set the ; Ack option to “checked” to allow the reader to trigger an alarm if desired. This
option is located in the Alarm Options tab. SG 6.5/SG 7 NOTE: in recent versions of SG, the ability to
auto-pop the DVR Viewer upon an armed alarm has been added. When this condition is met the GCS
DVR Viewer will automatically pop and play live video for the highest priority alarm.
6) Click [Apply] button to save changes.
Note: User can associate more than one Reader with a Camera, but not more than one camera to a Reader.

Figure 4: SG Door/Reader Properties Screen (composite image)
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2.6.2 To “associate” a Camera with an Input Device:
1) Open the Input Properties screen (from Menu Bar, select Configure>Hardware>Input Devices)
¾ TIP ~ Open Input Properties screen from short-menu by right-clicking the desired input icon in the
Hardware Tree, then selecting the ‘Properties’ option as illustrated. Loop, Controller and Input
Name fields should auto-fill to desired values when screen opens.
2) Choose the desired Loop, Control Unit and Input Name from drop lists as necessary.
3) Select the ‘RapidEye DVR Settings’ tab and click [Edit] button (fields become enabled).
4) Select the desired DVR and Camera from the drop lists.
5) Click the ; Show in Tree check box to allow the input’s camera option to be selectable from the short
menu in the SG Hardware Tree.
6) Click [Apply] button to save changes, then refresh Hardware Tree (close and re-open) to display the
input icon in the tree. Hardware Tree can be re-opened from the View Menu.
Note: User can associate more than one Input with a Camera, but not more than one camera with an Input.

Figure 5: SG Input Properties Screen (composite image)
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3 Operating GCS DVR Viewer
3.1 About the DVR Viewer
3.1.1 DVR Viewer Runtime Modes:
AUTO-RUN MODE (NORMAL): the DVR Viewer starts up and runs minimized when System Galaxy is started
running unless user closes the Viewer with the window control button (the [x] button on the top right corner of
window) ; or if the DVR Viewer is individually disabled (per workstation basis). See Section 4.1 for info on
enabling/disabling the Viewer on an individual workstation).
SG 7 NOTE: In System Galaxy 7 the GCS DVR Viewer will not auto-run at the start up of the SG application.
The GCS DVR Viewer will start when called for by a user or when auto-started by an incoming alarm.

SG 7 NOTE: DVR Support Enabled must be “ON” in Client Gateway (see Section 2.4.2)
IMPORTANT TIP: if DVR Viewer is closed inadvertently, it can be restarted by selecting the RapidEye
camera option from the short menu when right-clicking an event or alarm message.
STANDALONE MODE (diagnostic only) the DVR Viewer can run independently of SG (for trouble shooting
purposes) when correct connection parameters for logon and password are supplied. To find GCS Rapid Eye
executable, right-click the Window’s [Start] button and select the ‘Explorer’ option. Navigate to the C:\Program
Files\System Galaxy and double-click the GCS_RapidEye.exe. Enter the correct Logon and password
parameters.

3.1.2 DVR Viewer VIDEO Modes:
The GCS RapidEye DVR Viewer has two VIDEO modes. Both Live and historical feeds are accessible from this
DVR Viewer and are available from as far back as the DVR memory buffer can hold. See manufacturer’s
documentation for DVR memory limits.
¾

Live Video Feed: the DVR Viewer shows allows user to see live feed by two methods:
1. Select the ‘RapidEye Camera’ option from SG short-menu from a device, event or message in a
System Galaxy screen. Convenient short-menu options have been added throughout SG for quick
retrieval of video feeds. Note: This will restart the DVR Viewer if it has been closed.
2. When the user depresses the [Live] button and selects a camera from the camera drop list. See Section
3.1.3 figures and tables for details.

¾

Historical Video Feed: the DVR Viewer allows user to retrieve historical feed by two methods:
1. Select the ‘RapidEye Camera’ option from SG short-menu for a report item that has a date or time prior
to current. Note: The ‘Retrieval Controls’ become enabled/usable in this mode. See Section 3.1.3
figures and tables for details.
2. When the user selects the desired date and time, depresses the [Retrieve] button and chooses a
camera from the camera droplist. Note: The ‘Retrieval Controls’ become enabled/usable in this mode.
See Section 3.1.3 figures and tables for details.

Note: System Galaxy adds a 30 second padding to time requested for historical feeds. Therefore video retrieval
will begin playing at 30 seconds before requested time.

SG 7 NOTE: DVR Support Enabled must be “ON” in Client Gateway (see Section 2.4.2)
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3.1.3 DVR Viewer Controls:
The following picture shows a composite image of the GCS RapidEye Viewer.
Notice that the DVR name displays on the Viewer’s title once the DVR Definition is completed when running in
Auto-run Mode and the default GCS Viewer name displays in Standalone Mode. See Section 2.5 for DVR
Definition. See section 3.1.1 for description of runtime modes.
Buttons, drop lists, and fields are dynamically enabled/disable based on the current Video Mode. See section 3.1.2
for description of video modes.
 Connection Control fields are not displayed in auto-run mode; only available in standalone mode.
 Retrieval Control buttons only enable in Historical mode.

Figure 6: GCS RapidEye DVR Interface Viewer (composite). See Table 4 for definitions by function.
Date/Time and Calendar Controls

Real-time Clock
Video Mode Buttons
Camera List
Video Play Back Controls
(enabled historical video mode only)

allows switching
between historical
and live feeds

Connection Controls

Camera/Video
Session Pane

standalone runtime mode only
(not visible in auto-run mode)
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Figure 7: GCS DVR Viewer with Calendar Function expanded: (composite).
See Table 4 for definitions by function.

Calendar Function
expands when activated
to allow date selection
for historical feeds

Advance & Reverse buttons
allow user to select the
desired month

Advance & Reverse buttons
allow user to select desired month.

Today Indicator (red circle)

Up & Down buttons

red circle will appear on the current date
only if the current month is in view.

allow user to select
the desired year

Figure 8: GCS DVR Viewer with Skip Back drop list shown: (composite)
See Table 4 for definitions by function.
Note: System Galaxy adds 30 seconds to the start time on video retrieval.
Play
Step

Fast Forward

Pause

Super Fast Forward

Skip Back Buttons
allows user to skip backwards
by 5 minutes or 30 minutes.

Note: System Galaxy adds a 30
second padding to timestamp.

Skip Back Drop List
allows user to skip backwards
from current point in video feed,
by amount selected.
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Table 4: Definition of Functions and Controls on the GCS RapidEye DVR Viewer
Function Name

Picture

Definition
Mode of video feed for the GCS DVR screen.
Screen can display Live or Historical feeds. See
section 3.1.2 for details.

Video Modes

<< The Video Session pane my idle or empty in
this case.
The states of the buttons are
enabled and OFF (OUT).
The [Retrieve Video] button is a two-state push
button. (IN = ON; OUT = OFF).
When this button is IN, the Camera List is
enabled.

[ Retrieve Video ]
The state of the
[Retrieve Video] button
is enabled and ON (IN).

Retrieval Controls remain disabled until a
Camera is chosen and streaming begins.
<<This button will be disabled (grayed) when the
[Live] button is IN / ON.
The [Live] button is a two-state push button. (IN
= ON; OUT = OFF).
When this button is IN, the Camera List is
enabled.

[ Live ]

Retrieval Controls remain disabled in Live mode.
The state of the [Live] button
is enabled and ON (IN).

Video Session Pane

(See Figure 6)

<< This button will be disabled (grayed) when
the [Retrieve Video] button is IN / ON.
The Video Session Pane is the area where the
video feed will display when the appropriate
Mode and Camera selections have been made.
This pane will be blank/empty until a camera is
chosen from the camera drop list
The Camera drop list (on top right) will allow
user to select video feed taken from available
cameras.

[ Camera ]
drop list

Camera drop list is disabled until a Video Mode
button is selected / IN (i.e. Live or Retrieve…)
This list is dependant on the Site and System
configurations. See earlier sections on
associating cameras in the SG application.
Pauses (freezes) playback of digital video feed.

[ Pause ]

Only available in Retrieve Video (historical)
mode. Button will be disabled in Live mode or
until a camera is selected in Historical mode.
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Function Name

Picture

Definition
Advances the playback of digital video by one
frame at a time (one frame per click). The rate
at which a frame is captured is dependant on
how the DVR unit is programmed and can be
edited from the Honeywell RapidEye
View/Maintain/Video tab.

[ Step ]

Only available in Retrieve Video (historical)
mode. Button will be disabled in Live mode or
until a camera is selected in Historical mode.
Starts or Plays digital video feed at normal
playback rate.
[ Play ]

Record/Playback rate are equal and is not
determined by System Galaxy. The rate is
programmed to be at DVR unit.
There are two fast forward (FF) buttons/speeds.

[ Fast Forward ]

Fast Forward

buttons

These buttons play the digital video feed
forward at a faster playback rate than normal.
One FF rate of speed is faster than the other to
allow a choice of speeds to user.

Super Fast
There are two Skip Back # buttons / amounts.
(5* minutes)

The [ <5 ] button skips back to 5 minutes and
30 seconds before the ‘current play timestamp’.
The [ <30 ] button skips back to 30 minutes
and 30 seconds before the ‘current play
timestamp’.

[ Skip Back # ]
buttons
(30* minutes)

Note: System Galaxy adds 30 seconds to
time requested on these buttons. Therefore
video retrieval will begin playing at 30
seconds before requested time.
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Picture

RapidEye DVR

Definition
This function allows user more flexibility when
backing up video feeds. User can select from a
range of values up to 120 minutes.
This field should be blank or populated with
latest selection until next selection is made.

[ Skip Back ]
drop list

Note: you must pick the value from the list
each time even if you want to repeat the last
skip back value.

Note: System Galaxy adds 30 seconds to
time requested on these buttons. Therefore
video retrieval will begin playing at 30
seconds before requested time.
The Time field is always enabled and used to
retrieve historical feeds.
User can set the hour, minutes and seconds of
the video feed by over typing the value shown or
using the up/down buttons. The Up/Down arrow
buttons allow user to increment/decrement to
desired value in the ‘highlighted’ time segment
(hours, minutes, seconds) of the Time field.
[ Time ]

Select a segment by clicking on the current
value in that place/segment.

selection field
IMPORTANT: As with the Date/drop calendar,
the availability of historical feed and timesynchronization are dependant on memory and
or setup.
See Section 2.3 Step 11, for information on
time-synchronization options.
Note: System Galaxy adds 30 seconds to
time requested on these buttons. Therefore
video retrieval will begin playing at 30
seconds before requested time.
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Function Name

Picture

Definition
The Date is always enabled and used to retrieve
historical feeds. The Date field expands to
display a month-at-a-time calendar.
User may choose a date in the current month or
move the calendar to a different month or even
change the year.
A red circle indicates the current day if the
current month is in view.

[ Date ]
drop calendar

NOTE: availability of video feed is
dependant on whether the images for a given
date are still held in the memory buffer of the
physical DVR Unit. The size of the buffer is not
a System Galaxy control – see the
manufacturer’s information for these details.
IMPORTANT: requirements for time
synchronization apply.
See Section 2.3 Step 11, for information on
time-synchronization options.

[ RealTime Clock ]

Shows the real-time clocking / timestamp of the
currently playing video feed for Live and
Historical feeds.
The PTZ (pan/tilt/zoom) is not used. Rapid Eye
does not support camera positioning or
triggering of video recording for System Galaxy.

[ PTZ ]

This button is always disabled (grayed) in this
DVR Interface.
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4 Getting Video in System Galaxy
Once the DVR and Cameras have been installed, registered and configured in System Galaxy, the user will have
the ability to start the GCS DVR Viewer. A device must be linked to a camera in order to initiate video streaming
from and event message or device icon. If a camera has not been linked to a device (reader/door/input), the user
will only be able to select that camera from the open GCS DVR Viewer’s [Select Channel] droplist.
IMPORTANT: Selecting ‘View Video’ option from a message or device icon will cause the GCS DVR Viewer to
open if it has been completely closed.

4.1 Options for blocking GCS DVR Viewer
4.1.1 Blocking Viewer from specific Workstations
A customer may want the GCS DVR Viewer to be disabled at some workstations and not at others. The GCS
DVR features will be available by default at down-line SG Workstations once the DVR is registered at the
LCS/SG-Server. To disable the GCS DVR features at an individual PC, set the “DVR Enabled” option.
Disabling the DVR from the registry setting will mean that the DVR Settings tabs are not available in the
Reader and Input Properties screen and that the View Live Video option is not available from System Galaxy
Short Menus. The auto playback on Alarm screen will also be disabled. This applies on a “per workstation
basis”. Other PC’s will still be able to see video and set configurations.
SG 6.4 or 6.5 NOTE: To disable GCS DVR Viewer at an individual workstation, set the “DVR Enabled” key:
1) Go to Window’s Start>Run… option, then enter “regedit” in the ‘Open’ field and click [OK].
2) Expand the ‘My Computer’ tree, then open ‘HKEY_LOCAL_MACHINE’ folder
3) Open the following folders: SOFTWARE/GalaxyControlSystem/SystemGalaxy/RapidEye.
4) In the Right side task pane, double-click the “DVR Enabled” ICON to open edit dialog box.
5) Enter the desired value in the [Value data:] field and click [OK].
¾ “0” (zero) disables the GCS RapidEye Viewer (DVR Viewer does not run when SG runs)
¾ “1” (one) enables the GCS RapidEye Viewer (DVR Viewer runs minimized when SG runs)
SG 7 NOTE: To disable the GCS DVR Viewer at an individual workstation, set the “DVR Enabled” checkbox:
1) Navigate to SG Main Menu>Configure/Options/Workstation Options.
2) Select the General Options tab in the Workstation Options screen.
3) On the lower left-hand side of the screen set the [DVR Enabled] checkbox as desired:
¾ “unchecked” disables the GCS RapidEye Viewer (DVR Viewer will not start/run in SG)
¾ “checked” enables the GCS RapidEye Viewer (DVR Viewer will start/run in SG)

4.1.2 Blocking Viewer from auto-popping on Armed Alarms
SG 6.5/SG 7 NOTE: To enable/disable the GCS DVR Viewer from auto-popping on incoming Alarm:
1) Navigate to SG Main Menu>Configure/Options/Workstation Options.
2) Select the Alarm Options tab in the Workstation Options screen.
3) On the right-hand side of the screen set the [Automatically Call Up DVR] checkbox as desired:
¾ “unchecked” stops the Viewer from auto-popping on alarm (DVR Viewer will not auto-pop)
¾ “checked” allows the Viewer to auto-pop on incoming alarm (DVR Viewer will auto-pop)

SG 7 NOTE: ‘DVR Support Enabled’ checkbox must be “ON” in Client Gateway to support
menu options and DVR Viewer popping .(see Section 2.4.2 for instructions).
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4.2 Getting Live Video from Associated Doors/Inputs
The ‘RapidEye Camera’ option has been added to the short menu when a [Door/Reader icon] or an [Input icon] is
selected from the Hardware Tree in System Galaxy.
1) Right-click on a [Reader Icon] or [Input Icon] in the SG Hardware Tree that has been
associated with a camera. NOTE: Elevator icons (red door icon) will behave the same as standard
door icon.
2) Select the ‘RapidEye Camera’ option from the short-menu: This opens the GCS Rapid Eye Viewer
and shows Live Video feed with Real-Time clocking and time stamp for the camera configured.
Trouble Shooting Tips:
¾

If you are not seeing video the correct camera, revisit the section in Chapter 2 about associating
readers and input devices with cameras.

¾

If you are not seeing video at all, verify that you have performed all the steps given in Chapter 2
concerning the Setup of Rapid Eye Client side software and the System Galaxy setups for Registration
and Naming, and associating camera with the devices.

Also Remember that the system clocks on both the [System Galaxy PC’s] and the [physical DVR Unit] must be
synchronized to the same master clock source for accurate clocking/time stamping and synchronization between
the System Galaxy device and the video stream.
Figure 10: GCS DVR Viewer opened/activated from a Device Short-menu (composite image)
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4.3 Getting Live Video from a Device Status
The ‘RapidEye Camera’ option has been added to the short menu from a Device Status item:
1) Open the Device Status window by selecting View>Device Status from the SG main menu and select
the desired ‘Status Group’ (or add/edit a Status Group as needed) with the desired readers and inputs
included. Click [OK] to open the Device Status screen.
2) Right-click a [Device Status icon/item] associated with a camera to get the short-menu.
3) Select the ‘RapidEye Camera’ option from the short menu: This opens the GCS Rapid Eye viewer
and shows Live Video feed with Real-Time clocking and time stamp.
Trouble Shooting Tips:
¾

If you are not seeing video the correct camera, revisit the section in Chapter 2 about associating
readers and input devices with cameras.

¾

If you are not seeing video at all, verify that you have performed all the steps given in Chapter 2
concerning the Setup of Rapid Eye Client side software and the System Galaxy steps for Registration
and Naming, and associating camera with the device.

Also Remember that the system clocks on both the [System Galaxy PC’s] and the [physical DVR Unit] must be
synchronized to the same master clock source for accurate clocking/time stamping and synchronization between
the System Galaxy device and the video stream.
Figure 11: Device Status Screen
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4.4 Getting Live Video from the Loop Monitor Events
The ‘RapidEye Camera’ option has been added to the event item’s short-menu in the Loop Monitoring screen. The
Loop Monitoring screen and the Alarm Event screen are opened by default when System Galaxy is started running.
The screens show active logging of events and alarms depending on
1) In the Loop screen, Right-click an Event item which is associated with a camera to get the short-menu.
2) Select the ‘RapidEye Camera’ option from the short menu: The GCS Rapid Eye Viewer opens and
shows Live Video feed with Real-Time clocking/time stamp.
Remember that the clocks on the System Galaxy PC’s and the DVR unit must be synchronized to a common
master clock source for accurate clocking/time stamping. See Section 2.3 Step 11, for information on timesynchronization options.
Figure 12: SG Loop Monitor Screen with Events (composite)
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4.5 Getting Live Video from an Alarm Event
The ‘RapidEye Camera’ option has been added to the short-menu from the Event/Alarm screen:
SG 7 NOTE: The ‘View Live Video’ option will be displayed on the short-menu.
1) In the Loop screen, Right-click an Alarm which is associated with a camera to get the short-menu
2) Select the ‘RapidEye Camera’ option from the short menu: The Rapid Eye Viewer opens and
shows video feed with Real-Time clocking/time stamp.
SG 7 NOTE: Viewer can be set to automatically pop open for an incoming armed alarm. See Section 4.1.2 to
enable/disable auto pop on alarm and Sections 2.6.1 and 2.6.2 for configuration of alarms for inputs/doors/readers.

SG 7 NOTE: DVR Support Enabled must be “ON” in Client Gateway (see Section 2.4.2)
Figure 13: SG Alarm/Event Screen with alarms (composite)
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4.6 Getting Live Video from the Graphics screen
The ‘RapidEye Camera’ option has been added to the short-menu from the Graphics screen:
1) From the SG menu, select View>Graphics and right-click a Door or Input icon of a device that has
been associated with a camera to get the short-menu.
2) Select the ‘RapidEye Camera’ option from the short menu: The Rapid Eye Viewer opens and
shows video feed with Real-Time clocking/time stamp.
Remember that the clocks on the System Galaxy PC’s and the DVR unit must be synchronized to a common
master clock source for accurate clocking/time stamping. See Section 2.3 Step 11, for information on timesynchronization options.
Figure 14: SG Graphics Screen with short-menus for Doors and Input Icons (composite image)
Note: the GCS DVR Viewer will open when RapidEye Camera is selected.
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4.7 Getting Video from SG DVR Report Screen
System Galaxy includes new reporting features for the Rapid Eye interface. A digital video clip can be started from
the DVR Report screen by right clicking the message line on the DVR Report screen and selecting the ‘RapidEye
Camera’. The following pictures /instructions illustrate the abbreviated steps to open the DVR Report screen.
NOTE: Refer to SG Software Guide for details on the report options not associated with RapidEye Interface.
To open the DVR report screen, user must setup an Activity History Report and include the desired
selections (events) as needed.
1. From the main menu in System Galaxy application, select View>Reports>Activity History. The
Activity History Report Selections screen will open.

Figure 15: SG Menu - Opening the View>Reports>Activity History (composite)

<< continue to next page for instructions >>
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Once the Report Selections screen is open, user must choose the desired events by checking the
appropriate options to specify which activities (events) to include.
2. Select the desired loop and the devices to select by on the left side of desired tabs.
3. Click (check) the events as desired in the ‘Reader/Door’ tab from the ‘Specify activities to include’ group
of check-boxes.
4. Click (check) the events as desired in the ‘Input Devices’ tab from the ‘Specify activities to include’ group
of check-boxes.
5. Click (check) the DVR View check-box on the bottom right corner of the Report Selections screen
6. Click [View Report] button to open the DVR Report screen in the System Galaxy window.

Figure 16: SG Menu - Activity History Report Selections screen (composite)

<< continue to next page for instructions >>
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Once the SG DVR Report screen is open, user may start historical video for certain events where device
(reader/door/input) is “associated with a camera/DVR Unit. Choose the desired events by checking the
appropriate options to specify which activities (events) to include.
7. Right-click the desired event on the DVR Report screen
8. Select the short-menu option to ‘View RapidEye Video”.
9. The GCS RapidEye DVR Viewer will open and start video from 30 seconds prior to the event’s
timestamp.

Remember that the system clocks on both the [System Galaxy PC’s] and the [physical DVR Unit] must be
synchronized to the same master clock source for accurate clocking/time stamping and synchronization between
the System Galaxy device and the video stream.
Figure 17: SG Menu – DVR Report Screen with GCS DVR Viewer Playing Video (composite)
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